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OBJ Export for SketchUp Help 
 

Welcome to OBJ Export for SketchUp Help! 

 

This help file provides all the information you need to understand and use OBJ Export for 
SketchUp. Click the links below or use the Contents tab on the left to browse help topics. 
You can also scroll the topics on the above right hand pane.  

 

The OBJ Export for SketchUp help file is divided into the following sections: 

 Introduction - Introduction to OBJ Export for SketchUp. 

 Command Reference - Quick reference of all the commands added by OBJ Export for 
SketchUp. 

 Tutorial - Tutorial to get you started in the shortest possible time. 

 

If you need any additional information please contact SYCODE.  

 

Note: 

• If you have trouble loading the OBJ Export for SketchUp plug-in file into the 
SketchUp environment, please refer to the ReadMe file. 

• Please read the License Agreement before using the software. 
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Introduction 
 

OBJ Export for SketchUp is a Wavefront OBJ file export plug-in for Google SketchUp®. This 
plug-in gives SketchUp the ability to export objects in SketchUp to 3d polygon meshes in an 
OBJ file. 

OBJ Export for SketchUp tessellates objects in a SketchUp document into a set of triangular 
meshes. These meshes are then exported to an OBJ file as mesh objects. The OBJ file can 
then be imported into a variety of CAD applications. 

OBJ Export for SketchUp is very easy to use. Once installed, it automatically loads itself into 
SketchUp and adds a new submenu called "OBJ Export for SketchUp" to the SketchUp 
Plugins menu. 

OBJ Export for SketchUp comes with detailed documentation as well as a tutorial to get you 
started in the shortest possible time. 

If you need any additional information please contact SYCODE. 

 

The OBJ file format is a geometry definition file format first developed by Wavefront 
Technologies for its Advanced Visualizer animation package. The file format is open and has 
been adopted by other 3D graphics application vendors, making it a universally accepted 
geometry file format. The OBJ file format is a simple data format that represents 3D 
geometry alone - namely, the position of each vertex, the texture coordinate associated 
with a vertex, the normal at each vertex, and the faces that make each polygon. 

The OBJ File Format 
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License Agreement 
 

 
 

SYCODE END USER LICENSE AGREEMENT 
 

READ CAREFULLY: SYCODE LICENSES THIS SOFTWARE TO YOU ONLY UPON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE 
LICENSE AGREEMENT. 
 
BY SELECTING THE "I ACCEPT" BUTTON AT THE END OF THIS AGREEMENT OR BY 
COPYING, INSTALLING, UPLOADING, ACCESSING OR USING ALL OR ANY PORTION OF 
THE SOFTWARE YOU AGREE TO ENTER INTO THIS AGREEMENT.  A CONTRACT IS THEN 
FORMED BETWEEN SYCODE AND EITHER YOU PERSONALLY, IF YOU ACQUIRE THE 
SOFTWARE FOR YOURSELF, OR THE COMPANY OR OTHER LEGAL ENTITY FOR WHICH 
YOU ARE ACQUIRING THE SOFTWARE. 
 
IF YOU DO NOT AGREE OR DO NOT WISH TO BIND YOURSELF OR THE ENTITY YOU 
REPRESENT: (A) DO NOT COPY, INSTALL, DOWNLOAD, ACCESS OR USE THE 
SOFTWARE; (B) SELECT "I REJECT" AT THE END OF THIS AGREEMENT (WHICH WILL 
CANCEL THE LOADING OF THE SOFTWARE); AND (C) WITHIN THIRTY (30) DAYS FROM 
THE DATE OF ACQUISITION, RETURN THE SOFTWARE TO THE LOCATION WHERE YOU 
ACQUIRED IT FOR A REFUND. 
 
COPYING OR USE OF THIS SOFTWARE OR ANY ACCOMPANYING DOCUMENTATION 
EXCEPT AS PERMITTED BY THIS AGREEMENT IS UNAUTHORIZED AND CONSTITUTES A 
MATERIAL BREACH OF THIS AGREEMENT AND AN INFRINGEMENT OF THE COPYRIGHT 
AND OTHER INTELLECTUAL PROPERTY RIGHTS IN SUCH SOFTWARE AND 
DOCUMENTATION. IF YOU COPY OR USE ALL OR ANY PORTION OF THIS SOFTWARE OR 
ITS USER DOCUMENTATION WITHOUT ENTERING INTO THIS AGREEMENT OR 
OTHERWISE OBTAINING WRITTEN PERMISSION OF SYCODE, YOU ARE VIOLATING 
COPYRIGHT AND OTHER INTELLECTUAL PROPERTY LAW.  YOU MAY BE LIABLE TO 
SYCODE AND ITS LICENSORS FOR DAMAGES, AND YOU MAY BE SUBJECT TO CRIMINAL 
PENALTIES. 
 
 
1. DEFINITIONS 
 
1.1 "Access" means to use or benefit from using the functionality of the Software. 
 
1.2 "Computer" means a single electronic device with one or more central processing 
units (CPUs) that accepts information in digital or similar form and manipulates the 
information for a specific result based on a sequence of instructions.  
 
1.3 "Install" means to place a copy of Software onto a hard disk or other storage medium 
through any means (including, but not limited to, use of an installation utility application 
accompanying the Software). 
 
1.4 "License Parameters" means the definition and limitation of the applicable license 
scope in Section 2.2 hereof. 
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1.5 "Permitted Number" means a number relevant for the applicable License Parameters 
that SYCODE may specify in the applicable User Documentation. The Permitted Number 
is one (1) unless otherwise provided by SYCODE in writing. 
 
1.6 "Software" means the computer program in which this Agreement is embedded or 
that is delivered prepackaged with this Agreement. 
 
1.7 "User Documentation" means the explanatory printed or electronic materials that 
SYCODE or its authorized distributor incorporates in or delivers in or on a package with 
the Software or sends to You on an invoice, via email, facsimile or otherwise after You 
acquire or Install the Software, including, but not limited to, license specifications, 
activation key, license files, instructions on how to use the Software, and/or technical 
specifications. 
 
1.8 "You" means you personally (i.e., the individual who reads and is prompted to accept 
this Agreement) if you acquire the Software for yourself or the company or other legal 
entity for whom you acquire the Software. 
 
 
2. SOFTWARE LICENSE 
 
2.1 License Grant. SYCODE grants You a non-sublicensable, non-exclusive, non-
transferable, limited license to use copies of the Software in the jurisdiction in which you 
acquire the Software, in accordance with the applicable User Documentation, within the 
scope of the License Parameters. SYCODE’s license grant is conditioned on Your 
continuous compliance with all license limitations and restrictions described in this 
Agreement.  If You violate any of these limitations or restrictions, the license grant will 
automatically and immediately expire.  The license descriptions in this Section 2 define 
the scope of rights that SYCODE grants to You.  Any usage of the Software outside the 
scope of the applicable license grant constitutes an infringement of SYCODE’s intellectual 
property rights as well as a material breach of this Agreement. 
 
2.2 License Parameters.  SYCODE’s license grant is subject to one or more of the License 
Parameters defined in this Section 2.2 as specified in the User Documentation.  Unless 
SYCODE expressly specifies or agrees otherwise in the User Documentation, all Software 
shall be governed solely by a license for Standalone (Individual) Versions (see Section 
2.2.1). 
 
2.2.1 Standalone (Individual) Version.  If SYCODE identifies the Software as a 
"Standalone Version" or as an "Individual Version" or if the User Documentation does not 
identify the Software by any of the version designations set forth in Sections 2.2.2 
through 2.2.6, You may Install and Access one (1) copy of the Software on one (1) 
individual Computer, which may not be connected to a network in a manner that allows 
more than one (1) user to access, upload, operate, view or otherwise create or use a 
copy of the Software.  You may not install or access the Software other than on one (1) 
computer at a time. 
 
2.2.2 Network Version.  If SYCODE identifies the Software as a "Network Version" in the 
applicable User Documentation, You may Install, Access and use one (1) copy of the 
Software on Your Computer file server, for Your own internal business needs, with the 
SYCODE License Manager tool.  The Software may be Installed on or Accessed by other 
Computers, or on an individual Computer, as a multiple-user installation, so long as the 
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maximum number of concurrent users does not to exceed the Permitted Number. 
 
2.2.3 Educational Institutional Version. If SYCODE identifies the Software as an 
"Educational Institutional Version" in the applicable User Documentation, You may Install 
and Access a single copy of the Software on up to the Permitted Number of Computers, 
only for educational purposes (as further specified in the applicable User Documentation) 
and for no other purpose.  Without limiting the foregoing, Educational Institutional 
Versions of the Software may not be used for commercial, professional, or for-profit 
purposes.  Additionally, functional limitations apply, as set forth in Section 6. 
 
2.2.4 Student Version. If SYCODE identifies the Software as a "Student Version" in the 
applicable User Documentation, You may Install and Access a single copy of the Software 
on up to the Permitted Number of Computers, only for personal learning purposes, and 
no other purpose.  Unless otherwise provided by SYCODE in the User Documentation, 
Student Versions of the Software may be used for a period of one (1) year from the date 
of Installation. Without limiting the foregoing, Student Versions of the Software may not 
be used for commercial, professional or other for-profit purposes and may only be used 
by persons who qualify as a permitted user of Student Versions (as further specified in 
the applicable User Documentation for the jurisdiction in which the Software is acquired). 
Additionally, functional limitations apply, as set forth in Section 6. 
 
2.2.5 Evaluation Version. If SYCODE identifies the Software as a demonstration, 
evaluation, trial, or not for resale version ("Evaluation Version") in the applicable User 
Documentation, You may Install and Access one copy of the Software only for the 
purpose of commercial evaluation and demonstration.  Without limiting the foregoing, 
You may not use it for competitive analysis, or commercial, professional, or for-profit 
purposes. The Evaluation Version may only be Installed for a ten (10) day evaluation 
period, unless otherwise specified by SYCODE in writing.  Additionally, functional 
limitations apply, as set forth in Section 6. 
 
2.2.6 License Term. Subject to the terms and conditions of this Agreement, the license to 
use the Software is perpetual, unless the Software qualifies as an Evaluation Version, 
Student Version, or is designated as a fixed-term license, a limited duration license or a 
rental license.  In such case, the term of the license shall be the term identified by 
SYCODE in the applicable User Documentation (the "Designated Term") or the term for 
which You have paid, whichever is less.  If SYCODE identifies the Software as licensed for 
a fixed term, limited duration or rental and does not specify a term, then the Designated 
Term shall expire thirty (30) days after the date You first Install the Software. Use of this 
Software beyond the applicable license term, or any attempt to defeat the time-control 
disabling function in the Software is an unauthorized use and constitutes a material 
violation of this Agreement and intellectual property law. 
 
2.3 Software Components.  The Software is licensed to You as a single product and its 
components may not be separated for distribution or use on more than one (1) 
Computer unless expressly permitted by SYCODE in the applicable User Documentation. 
 
 
3. PERMITTED AND PROHIBITED ACTIONS 
 
3.1 Permitted Actions 
 
3.1.1 Backup Copy. Regardless of which version of the Software You have acquired, You 
may Install one archival (backup) copy of the Software. Such archival copy may not be 



OBJ Export for SketchUp Help 

6 

Installed on another Computer, unless such other Computer is a partitioned drive of a 
server to which only the user of the active copy of the Software can Access. In any 
event, the archival copy may not be Accessed as long as another copy of the Software is 
Installed on any Computer. Except as expressly permitted under Section 2.2: (a) if the 
User Documentation is in printed form, it may not be copied; and (b) if the User 
Documentation is in electronic form, it may not be duplicated electronically. 
 
3.1.2 Additional Installation. Except with regard to Educational Institutional, Student and 
Evaluation Versions only, You may Install and Access a second copy of the Software on 
the hard disk of a second Computer owned by You or under Your control provided that: 
 
(i) the original and second copies are used only by the same person; 
 
(ii) the second copy is Installed and Accessed only on either (a) with respect to Network 
Versions, a redundant server that makes the Software available for use only when Your 
primary server on which the active Software copy is Installed becomes inoperable, or (b) 
a notebook computer or other non-server computer away from Your usual work location 
for the purpose of enabling You to perform work while away from Your usual work 
location;  
 
(iii) only one of the Software copies is Accessed at any one time; and 
 
(iv) both copies of the Software are Installed and Accessed exclusively with the copy 
protection device (if any) supplied with the Software. 
 
(v) You have an active Subscription for the Software. 
 
3.2 Prohibited Actions. SYCODE does not permit any of the following actions and You 
acknowledge that such actions shall be prohibited: 
 
3.2.1 Use. You may not Install, Access or otherwise copy or use the Software or User 
Documentation except as expressly authorized by this Agreement. 
 
3.2.2 Reverse Engineering. You may not reverse engineer, decompile, or disassemble the 
Software. 
 
3.2.3 Transfers. You may not distribute, rent, loan, lease, sell, sublicense, or otherwise 
transfer all or any portion of the Software or User Documentation, or any rights granted 
in this Agreement, to any other person without the prior written consent of SYCODE. 
 
3.2.4 Hosting or Third Party Use. You may not Install or Access, or allow the Installation 
or Access of, the Software over the Internet, including, without limitation, use in 
connection with a Web hosting or similar service, or make the Software available to third 
parties via the Internet on Your computer system or otherwise. 
 
3.2.5 Distribution. You may not distribute the Software to another party, without prior 
written permission from SYCODE. Distribution includes, but is not limited to, sending the 
Software by electronic mail, placing the Software on a web server or a similar on-line 
source, including the software on a CD or any other media or any other distribution 
mechanism. 
 
3.2.6 Notices. You may not remove, alter, or obscure any proprietary notices, labels, or 
marks from the Software or User Documentation. 
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3.2.7 Modifications. You may not modify, translate, adapt, arrange, or create derivative 
works based on the Software or User Documentation for any purpose.  
 
3.2.8 Circumvention. You may not utilize any equipment, device, software, or other 
means designed to circumvent or remove any form of copy protection used by SYCODE 
in connection with the Software, or use the Software together with any, activation code, 
serial number, or other copy protection device not supplied by SYCODE directly or 
through an authorized distributor. 
 
3.2.9 Export. You may not export the Software or User Documentation in violation of this 
Agreement, Indian or other applicable export control laws. 
 
 
4. ALL RIGHTS RESERVED 
 
Except as expressly provided otherwise in this Agreement, title, ownership and all rights 
and interest including, without limitation, copyrights, in and to the Software and User 
Documentation and any authorized copies made by You remain with SYCODE and its 
licensors. The structure, organization, and code of the Software are valuable trade 
secrets of SYCODE and its licensors and You shall keep such trade secrets confidential. 
The Software and User Documentation are licensed, not sold. 
 
 
5. DISCLAIMER 
 
ANY STATEMENTS OR REPRESENTATIONS ABOUT THE SOFTWARE AND ITS 
FUNCTIONALITY IN THE USER DOCUMENTATION OR ANY COMMUNICATION WITH YOU 
CONSTITUTE TECHNICAL INFORMATION AND NOT AN EXPRESS WARRANTY OR 
GUARANTEE.  IN ADDITION, SYCODE SPECIFICALLY DISCLAIMS ANY OTHER WARRANTY 
INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTY OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT. WITHOUT LIMITING 
THE FOREGOING, SYCODE DOES NOT WARRANT THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE. 
 
6. WARNINGS 
 
6.1 Functionality Limitations. COMPUTER AIDED DESIGN SOFTWARE AND OTHER 
TECHNICAL SOFTWARE ARE TOOLS INTENDED TO BE USED BY TRAINED 
PROFESSIONALS ONLY. THEY ARE NOT SUBSTITUTES FOR YOUR PROFESSIONAL 
JUDGMENT. COMPUTER AIDED DESIGN SOFTWARE AND OTHER TECHNICAL SOFTWARE 
ARE INTENDED TO ASSIST WITH PRODUCT DESIGN AND ARE NOT SUBSTITUTES FOR 
INDEPENDENT TESTING OF PRODUCT STRESS, SAFETY AND UTILITY. DUE TO THE 
LARGE VARIETY OF POTENTIAL APPLICATIONS FOR THE SOFTWARE, THE SOFTWARE 
HAS NOT BEEN TESTED IN ALL SITUATIONS UNDER WHICH IT MAY BE USED. SYCODE 
SHALL NOT BE LIABLE IN ANY MANNER WHATSOEVER FOR THE RESULTS OBTAINED 
THROUGH THE USE OF THE SOFTWARE. PERSONS USING THE SOFTWARE ARE 
RESPONSIBLE FOR THE SUPERVISION, MANAGEMENT AND CONTROL OF THE 
SOFTWARE. THIS RESPONSIBILITY INCLUDES, BUT IS NOT LIMITED TO, THE 
DETERMINATION OF APPROPRIATE USES FOR THE SOFTWARE AND THE SELECTION OF 
THE SOFTWARE AND OTHER PROGRAMS TO ACHIEVE INTENDED RESULTS.  PERSONS 
USING THE SOFTWARE ARE ALSO RESPONSIBLE FOR ESTABLISHING THE ADEQUACY OF 
INDEPENDENT PROCEDURES FOR TESTING THE RELIABILITY AND ACCURACY OF ANY 
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PROGRAM OUTPUT, INCLUDING ALL ITEMS DESIGNED BY USING THE SOFTWARE. 
 
 
6.2 Activation Key Required. 
 
6.2.1 INSTALLATION, ACCESS, TRANSFERS AND CONTINUED USE OF THE SOFTWARE 
MAY REQUIRE AN ACTIVATION KEY. YOU MUST REGISTER YOUR ACQUISITION OF THE 
SOFTWARE WITH SYCODE BEFORE AN ACTIVATION KEY IS ISSUED TO YOU.  
 
6.2.2 THE ACTIVATION SECURITY MECHANISMS MAY DISABLE THE SOFTWARE IF YOU 
TRY TO TRANSFER IT TO ANOTHER COMPUTER, IF YOU TAMPER WITH THE DATE 
SETTING MECHANISMS ON YOUR COMPUTER, IF YOU USE THE SOFTWARE PAST AN 
APPLICABLE EVALUATION PERIOD OR LIMITED TERM, OR IF YOU UNDERTAKE CERTAIN 
OTHER ACTIONS THAT MAY OFFSET THE SECURITY MODE. MORE INFORMATION IS 
CONTAINED IN THE APPLICABLE USER DOCUMENTATION OR AVAILABLE FROM SYCODE 
ON REQUEST.  
 
 
7. LIMITATION OF LIABILITY 
 
IN NO EVENT SHALL SYCODE OR ITS LICENSORS HAVE ANY LIABILITY FOR ANY 
INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS, 
REVENUE, DATA, OR COST OF COVER.  IN ADDITION, IN NO EVENT SHALL THE 
LIABILITY OF SYCODE OR ITS LICENSORS FOR ANY DAMAGES ARISING OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THIS AGREEMENT EXCEED THE AMOUNT PAID 
OR PAYABLE BY YOU FOR THE SOFTWARE PRINCIPALLY RESPONSIBLE FOR SUCH 
DAMAGES. THE LIMITATIONS OF LIABILITY IN THIS SECTION 7 SHALL APPLY TO ANY 
DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, 
WHETHER DERIVED FROM CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, 
NEGLIGENCE), OR OTHERWISE, EVEN IF SYCODE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES AND REGARDLESS OF WHETHER THE LIMITED 
REMEDIES AVAILABLE HEREUNDER FAIL OF THEIR ESSENTIAL PURPOSE. 
 
 
8. GENERAL 
 
8.1. No Assignment; Insolvency. This Agreement and any rights hereunder are non-
assignable and any purported assignment shall be void. The Agreement and the licenses 
granted hereunder shall terminate without further notice or action by SYCODE if You 
become bankrupt or insolvent, make an arrangement with Your creditors or go into 
liquidation.  
 
8.2. Choice of Law. This Agreement and any disputes arising out of or in connection with 
this Agreement shall be governed by the laws of the state of Goa in India without 
reference to conflict-of-laws principles and excluding the UN Convention on Contracts for 
the International Sale of Goods.  
 
8.3 Entire Agreement. This Agreement and the applicable User Documentation constitute 
the entire agreement between You and SYCODE and supersede any other previous or 
contemporaneous communications, agreements, representations, or advertising with 
respect to the Software and User Documentation. 
 
8.4 Severability. If and to the extent any provision of this Agreement is held illegal, 
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invalid, or unenforceable in whole or in part under applicable law, such provision or such 
portion thereof shall be ineffective as to the jurisdiction in which it is illegal, invalid, or 
unenforceable to the extent of its illegality, invalidity, or unenforceability and shall be 
deemed modified to the extent necessary to conform to applicable law so as to give the 
maximum effect to the intent of the parties. The illegality, invalidity, or unenforceability 
of such provision in that jurisdiction shall not in any way affect the legality, validity, or 
enforceability of any other provision of this Agreement in any other jurisdiction. 
 
8.5 Audits. To ensure compliance with this Agreement, You agree that upon reasonable 
notice, SYCODE or SYCODE’s authorized representative shall have the right in inspect 
and audit Your Installation, Access and use of the Software.  Any such inspection or audit 
shall be conducted during regular business hours at Your facilities or electronically. If 
such inspections or audits disclose that You have Installed, Accessed or permitted Access 
to the Software on Computer(s) in a manner that is not permitted under this Agreement, 
then SYCODE may terminate this Agreement immediately and You are liable to pay for 
any unpaid license fees as well as the reasonable costs of the audit.  Nothing in this 
section shall be deemed to limit any legal or equitable remedies available to SYCODE for 
violation of this Agreement or applicable law.  
 
8.6 Language. The English language version of this Agreement is legally binding in case 
of any inconsistencies between the English version and any translations. 
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ReadMe 
 

This is an OBJ Export for SketchUp ReadMe file. 
  

   
OBJ Export for SketchUp is a plug-in for Google SketchUp  
 
Installation: 
============= 
The plug-in installation involves copying the plug-in file "OBJExport.dll" 
into SketchUp's plug-ins folder typically called "Plugins". The installer 
automatically does that for you so that the OBJ Export for SketchUp is 
loaded automatically the next time you run SketchUp. For some reason, if 
the installer was unable to locate the SketchUp installation folder, it 
will prompt you to specify the folder during the installation process. 
 
Usage: 
====== 
OBJ Export for SketchUp adds new commands to SketchUp. It also adds a new 
menu to SketchUp called "OBJExport" under SketchUp's "Plugins" menu 
containing these new commands. Simply click on the menu items in the 
"OBJExport" menu to run these new commands. 
 
The new commands are: 
1) Export - Export a Wavefront OBJ file 
2) Help - Display the OBJ Export for SketchUp help file 
3) Register - Register your copy of OBJ Export for SketchUp 
4) About - Display the OBJ Export for SketchUp about box 
 
Sample files are copied into the Samples folder (typically "C:\Program 
Files\SYCODE\OBJ Export for SketchUp\Samples"). You can use these sample 
files to try OBJ Export for SketchUp. 
 
Support: 
======== 
For support, please E-Mail support@sycode.com 
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Contact 
 

 
Mailing address S1/116, Nova Cidade Complex, 

NH 17, Alto Porvorim,  
Goa - 403521  
India  

Phone +91 9822689298 
Fax +91 832 2416615 
E-Mail info@sycode.com 

Web Site http://www.sycode.com 

 

mailto:info@sycode.com�
http://www.sycode.com/�
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Command Reference 
 

 
OBJ Export for SketchUp adds new commands to SketchUp. It also adds a submenu to the 
SketchUp menu called "OBJ Export for SketchUp" containing these new commands. Simply 
click on the menu items in this sub menu to run these new commands. 

 

The new commands are: 

Export Exports a Wavefront OBJ file 
Help Displays the OBJ Export for SketchUp help file 
Register Displays the OBJ Export for SketchUp product registration dialog box 
About Displays the OBJ Export for SketchUp about box 
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Export 
 

Menu Button Plugins > OBJ Export for SketchUp > Export 

 
This command exports to an OBJ file. 

 

To export an OBJ file 
  

1. Select Export from the "OBJ Export for SketchUp" submenu 
 
2. The SketchUp "Save As" dialog box is displayed. Enter the name of a OBJ file and click 
Save. 
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Help 
 

Menu Button Plugins > OBJ Export for SketchUp > Help 

 
This command displays the help file. The Welcome page is a good place to start. 
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Register 
 

Menu Button Plugins > OBJ Export for SketchUp > Register 

 
This is command used to register your copy of OBJ Export for SketchUp.  

The dialog box contains the product name (including version) and lock number. During the 
trial period this dialog box will be displayed every time you run the command. You can click 
the "Continue Trial" button to close the dialog box and continue evaluating the software. 
After the trial period ends, you will have to enter the key to continue working. 

The Product Registration dialog box is shown below. 

 

 
 

Note: 

• To avoid disruption in your work-flow we urge you to place your order before the trial 
period ends. 
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About 
 

Menu Button Plugins > OBJ Export for SketchUp > About 

 
This command displays the OBJ Export for SketchUp About box. The About box lists the 
software version and name of the person and company the software is licensed to. 

The software version has three parts: major version, minor version and build number (in 
the form #.#.#). In the About box shown below the version is 1.0, which translates as 
major version = 1, minor version = 0. There is no build number. 
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Tutorial 
 

 
This tutorial provides the necessary information and hands-on experience to help you get 
started with OBJ Export for SketchUp. 

 

Step 1: Start SketchUp 
 
Step 2: Select Open from the "File" menu. The SketchUp "Open File" dialog box is 
displayed. Browse for the file typically located at "C:\Program Files\SYCODE\OBJ Export for 
SketchUp\Samples\Sample 1.skp") and click OK to open. 
 
Step 3: Run the Export command (Plugins >> OBJ Export for SketchUp >> Export). 
 
Step 4: The SketchUp "Save As" dialog box is displayed. Enter the name of a OBJ file and 
click Save. 

 

 
  

 

The model will be exported to the OBJ file you specified. 
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